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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.
Documentation disclaimer
“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF

YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.
Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).
Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License as set forth
below in the Designated System(s) License (DS) section as
applicable. The applicable number of licenses and units of capacity
for which the license is granted will be one (1), unless a different
number of licenses or units of capacity is specified in the
documentation or other materials available to You. “Software” means
computer programs in object code, provided by Avaya or an Avaya
Channel Partner, whether as stand-alone products, pre-installed on
hardware products, and any upgrades, updates, patches, bug fixes,
or modified versions thereto. “Designated Processor” means a single
stand-alone computing device. “Server” means a set of Designated
Processors that hosts (physically or virtually) a software application
to be accessed by multiple users. “Instance” means a single copy of
the Software executing at a particular time: (i) on one physical
machine; or (ii) on one deployed software virtual machine (“VM”) or
similar deployment.
License type(s)
Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time as indicated in the order,
Documentation, or as authorized by Avaya in writing. A “Unit” means
the unit on which Avaya, at its sole discretion, bases the pricing of its
licenses and can be, without limitation, an agent, port or user, an e-
mail or voice mail account in the name of a person or corporate
function (e.g., webmaster or helpdesk), or a directory entry in the
administrative database utilized by the Software that permits one
user to interface with the Software. Units may be linked to a specific,
identified Server or an Instance of the Software.
Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
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Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.
Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Unless
otherwise stated, each Instance of a product must be separately
licensed and ordered. For example, if the end user customer or
Avaya Channel Partner would like to install two Instances of the
same type of products, then two products of that type must be
ordered.
Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.
The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE H.264 CODEC OR H.265 CODEC, THE AVAYA CHANNEL
PARTNER ACKNOWLEDGES AND AGREES THE AVAYA
CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND ALL
RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC) CODEC
IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE
FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES
IN WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I)
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED
OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
Compliance with Laws
You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.
Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.
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Chapter 1: Introduction

This document describes how to deploy, commission, and test Avaya Contact Center Select using
an ISO image on Microsoft Azure Cloud.

This document does not describe IP Office basic configuration for system settings, licensing, or
networking. This document describes only how to integrate a working IP Office server with Avaya
Contact Center Select.

Purpose
This document describes how to install and commission Avaya Contact Center Select on Microsoft
Azure Cloud (Azure).

Intended audience
This document is intended for personnel who install Avaya Contact Center Select.

Related resources
The following are some additional Avaya Contact Center Select related resources.

Avaya Contact Center Select Documentation
The following table lists the documents related to Avaya Contact Center Select. Download the
documents from the Avaya Support website at http://support.avaya.com.

Title Use this document to: Audience
Overview

Table continues…
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Title Use this document to: Audience
Avaya Contact Center Select
Solution Description

This document provides a technical
description of Avaya Contact Center Select.
It describes the product features,
specifications, licensing, and
interoperability with other supported
products.

Customers and sales,
services, and support
personnel

Avaya Contact Center Select
Documentation Catalog

This document describes available Avaya
Contact Center Select documentation
resources and indicates the type of
information in each document.

Customers and sales,
services, and support
personnel

Contact Center Performance
Management Data Dictionary

This document contains reference tables
that describe the statistics and data in the
historical and real-time reports generated in
Contact Center.

System
administrators and
contact center
supervisors

Implementing
Deploying Avaya Contact Center
Select DVD

This document contains information about
Avaya Contact Center Select DVD
installation, initial configuration, and
verification. This document contains
information about maintaining and
troubleshooting the Avaya Contact Center
Select server.

Implementation
personnel

Deploying Avaya Contact Center
Select Software Appliance

This document contains information about
Avaya Contact Center Select Software
Appliance (VMware) preparation,
deployment, initial configuration, and
verification. This document contains
information about maintaining and
troubleshooting the software appliance.

Implementation
personnel

Deploying Avaya Contact Center
Select Hardware Appliance

This document contains information about
Avaya Contact Center Select Hardware
Appliance (physical server) installation,
initial configuration, and verification. This
document contains information about
maintaining and troubleshooting the
hardware appliance.

Implementation
personnel

Deploying Avaya Contact Center
Select on Microsoft Azure

This document contains information about
deploying Avaya Contact Center Select
using an ISO image on Microsoft Azure.

Implementation
personnel

Avaya Contact Center Select
Business Continuity

This document contains information about
deploying Avaya Contact Center Select
Business Continuity.

Implementation
personnel

Table continues…
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Title Use this document to: Audience
Upgrading and patching Avaya
Contact Center Select

This document contains information about
upgrading and patching Avaya Contact
Center Select.

Implementation
personnel and
system
administrators

Administering
Administering Avaya Contact Center
Select

This document contains information and
procedures to configure the users, skillsets,
and contact center configuration data. This
document contains information about
creating Avaya Contact Center Select real-
time and historical reports.

System
administrators and
contact center
supervisors

Avaya Contact Center Select
Advanced Administration

This document contains information about
managing the Avaya Contact Center Select
server, licensing, and multimedia
configuration.

System
administrators

Using Contact Center Orchestration
Designer

This document contains information and
procedures to configure script and flow
applications in Contact Center
Orchestration Designer.

System
administrators

Maintaining
Contact Center Event Codes This document contains a list of errors in

the Contact Center suite and
recommendations to resolve them.

This document is a Microsoft Excel
spreadsheet.

System
administrators and
support personnel

Using
Using Agent Desktop for Avaya
Contact Center Select

This document provides information and
procedures for agents who use the Agent
Desktop application to accept, manage,
and close contacts of all media types in
Contact Center.

Contact center
agents and
supervisors

Using the Contact Center Agent
Browser application

This document provides information and
procedures for agents who use the Agent
Browser application to log on to Contact
Center and perform basic tasks.

Contact center
agents

Using Avaya Workspaces for AACC
and ACCS

This document describes the tasks that
Contact Center agents can perform using
Avaya Workspaces.

Contact center
agents and
supervisors

Finding documents on the Avaya Support website
Procedure

1. Go to https://support.avaya.com.

2. At the top of the screen, type your username and password and click Login.

Related resources
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3. Click Support by Product > Documents.

4. In Enter your Product Here, type the product name and then select the product from the
list.

5. In Choose Release, select the appropriate release number.

The Choose Release field is not available if there is only one release for the product.

6. In the Content Type filter, click a document type, or click Select All to see a list of all
available documents.

For example, for user guides, click User Guides in the Content Type filter. The list only
displays the documents for the selected category.

7. Click Enter.

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot
Avaya products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

• To find videos on the Avaya Support website, go to https://support.avaya.com/ and do one of
the following:

- In Search, type Avaya Mentor Videos, click Clear All and select Video in the Content
Type.

- In Search, type the product name. On the Search Results page, click Clear All and select
Video in the Content Type.

The Video content type is displayed only when videos are available for that product.

In the right pane, the page displays a list of available videos.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and do
one of the following:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click a topic name to see the list of videos available for the topic.
For example, Contact Centers.

Note:

Videos are not available for all products.

Introduction
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Support
Go to the Avaya Support website at https://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Microsoft Azure documentation
For information about the Microsoft Azure functionality, go to the Microsoft documentation website
at https://docs.microsoft.com/en-us/azure/.

Support
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Chapter 2: Overview

The Avaya Contact Center Select software provides a context-sensitive, collaborative, voice and
multimedia customer experience solution. Avaya Contact Center Select allows small and midsize
enterprises to anticipate, accelerate, and enhance customer interactions. Avaya Contact Center
Select uses the Avaya IP Office telephone system to provide a real-time telephony platform. IP
Office is a flexible and scalable phone system designed specifically for small and midsize
enterprises. It supports a wide range of phones and devices for use in contact centers.

The Avaya Contact Center Select DVD deployment option supports Platform Vendor Independence
(PVI). Avaya Contact Center Select provides the flexibility to purchase a server that meets the PVI
server specification and conforms to your corporate standards.

To use the Avaya Contact Center Select on Microsoft Azure, provide the following:

• The Microsoft Azure subscription applicable to all Avaya Contact Center Select components

• A sever that meets the Avaya Contact Center Select PVI specification

• Microsoft Windows Server 2012 R2 or Windows Server 2016 operating system and license

Note:

Windows Server 2019 does not support Avaya Contact Center Select on Microsoft Azure.

The following diagram shows the topology of a typical Avaya Contact Center Select on Microsoft
Azure solution:

April 2022 Deploying Avaya Contact Center Select on Microsoft Azure 12
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Contact Center Select on Microsoft Azure


Figure 1: Avaya Contact Center Select on Azure solution topology

Avaya Contact Center Select is preloaded with sample users, skillsets, and contact center
parameters. You can use this sample data to commission the solution and make the first routed call
and email contact. Avaya Contact Center Select delivers quick and simplified contact center
deployment. After the basic telephony features start working, you can configure multimedia
contacts, multiplicity, custom prompts, and other enhanced features and functions to improve your
customer’s experience.

The Avaya Contact Center Select ISO image contains the following software components:

• Contact Center Manager Server (CCMS)

• Contact Center Manager Administration (CCMA)

• Communication Control Toolkit (CCT)

• Contact Center License Manager (LM)

• Contact Center Manager Server Utility (SU)

• Avaya Orchestration Designer (OD)
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• Contact Center Multimedia (CCMM)

• Avaya Contact Center Select Firewall policy

• Default Avaya Contact Center Select configuration data

• An Ignition Wizard configuration utility

The Avaya Contact Center Select server is supported in a work group or in a Windows domain. After
you deploy Avaya Contact Center Select, you can add the server to a Windows domain.

Avaya Contact Center Select on Microsoft Azure
architecture

The following diagram shows the Avaya Contact Center Select on Microsoft Azure architecture:

Figure 2: Avaya Contact Center Select on Microsoft Azure architecture

Overview
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Chapter 3: Prerequisite procedures

Prerequisites
To deploy Avaya Contact Center Select on Microsoft Azure, you need the following knowledge,
skills, tools, and components.

Knowledge
• Microsoft Azure setup
• Windows Operating System
• Linux® Operating System

Skills
Ability to administer Microsoft Azure, IP Office, and Avaya Contact Center Select.

Configuration tools and utilities
• A browser for accessing the Microsoft Azure Management Console
• PuTTY, PuTTYgen, WinSCP, and WinZip

Components
• Microsoft Azure subscription with owner or contributor privilege
• Avaya IP Office, Avaya Aura® Media Server, Avaya Contact Center Select, and Avaya

WebLM ISO images to use on Microsoft Azure
• On-Premise firewall device for the Virtual Private Network (VPN) connection

For more information on how to create a site-to-site connection in the Microsoft Azure portal,
see https://docs.microsoft.com/en-us/azure/vpn-gateway/tutorial-site-to-site-portal

• License files for all components in Avaya Contact Center Select

Deployment process
To deploy Avaya Contact Center Select on Microsoft Azure you need to perform the following
procedures:

1. On Microsoft Azure, create a resource group for the following components:
• Avaya IP Office
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• Avaya Aura® Media Server
• Avaya WebLM
• Avaya Contact Center Select server

2. In the resource group, create a virtual network (VNet).
3. Deploy and configure IP Office on Microsoft Azure.
4. Deploy and configure Avaya Aura® Media Server on Microsoft Azure.
5. Deploy and configure Avaya WebLM on Microsoft Azure.
6. Deploy and configure Avaya Contact Center Select on Microsoft Azure.

Signing in to the Microsoft Azure portal
About this task
Sign in to your Microsoft Azure account.

Before you begin
Create a Microsoft Azure account and obtain a Microsoft Azure subscription with the Owner or
Contributor privilege.

Procedure
1. In your web browser, enter https://portal.azure.com/

The web browser displays the Microsoft Azure Sign-in page.

2. In the Email, phone, Skype field, type the registered email ID.

3. In the Password field, type your password.

4. Click Sign in.

Result
The web browser displays the Microsoft Azure portal.

Creating a resource group
About this task
A resource group is used to contain sets of related servers.
Create a resource group and use it for the following components:

• IP Office
• Avaya Aura® Media Server

Prerequisite procedures
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• Avaya WebLM
• Avaya Contact Center Select

Note:
Microsoft might periodically update the Microsoft Azure instructions. For the latest and most
accurate information, see https://docs.microsoft.com/en-us/azure/..

Procedure
1. Log in to the Microsoft Azure portal: https://portal.azure.com/.

2. In the Search field, type resource groups.

3. In the Services list, select Resource groups.

4. In the Resource groups window, click Create.

5. On the Basics tab, fill in all the required fields.

6. Click Review + Create.

7. Click Create.

Result
The created resource group appears in the list of resource groups.

Creating a virtual network in a resource group
About this task
After you create a resource group, you must create a virtual network within that resource group.
Microsoft Azure Virtual Network (VNet) is the basic element of your Microsoft Azure network. VNet
ensures that all Microsoft Azure resources securely communicate with each other, the internet,
and on-premises networks.
Create a virtual network and use it for the following components:

• IP Office
• Avaya Aura® Media Server
• Avaya WebLM
• Avaya Contact Center Select

Before you begin
Ensure that the resource group that you created is available.

Procedure
1. Log in to the Microsoft Azure portal: https://portal.azure.com/.

2. In the Search field, type virtual networks.

Creating a virtual network in a resource group
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3. In the Services list, select Virtual networks.

4. In the Virtual networks window, click Create.

5. On the Basics tab, fill in all the required fields.

6. Click Next: IP Addresses.

7. On the IP address tab, add the required IP addresses.

8. Click Next: Security.

9. On the Security tab, leave the default security settings.

10. Click Review + Create.

11. Click Create.

The Microsoft Azure portal displays the Overview page with the details about the created
virtual network.

12. In the portal menu pane, select Virtual networks.

The list of available virtual networks appears.

13. From the list, click the name of the required network.

14. Under Settings, click Subnets.

The Subnets page appears.

15. Click + Subnet.
16. In the Add subnet pane, perform the following:

a. In the Name field, type the name of the subnet.

b. In the Subnet address range field, type the IP address range of the subnet.

These IP addresses are used to assign to virtual machines.

c. Click Save.

Prerequisite procedures
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Chapter 4: IP Office configuration

IP Office servers are supported as virtual machines within the Microsoft Azure environment.
Configure IP Office to integrate with Avaya Contact Center Select. This chapter does not describe IP
Office deployment on Microsoft Azure, as well as basic configuration for system settings, licensing,
or networking. This section describes only how to integrate a working IP Office virtual server with
Avaya Contact Center Select. For more information about deployment and basic configuration of IP
Office on Microsoft Azure, see Deploying Avaya IP Office Servers as Virtual Machines.

The procedures in this section use examples to describe how to configure IP Office to integrate with
Avaya Contact Center Select. The IP Office configuration values used in the following procedures
match the default values used by Avaya Contact Center Select. These values might not be suitable
for your solution. If you use different IP Office configuration values, remember to enter the different
values when installing and commissioning Avaya Contact Center Select.

Avaya recommends that you configure IP Office before installing Avaya Contact Center Select.

You must complete the procedures in this IP Office section in sequential order.

IP Office supported versions
Each Avaya Contact Center Select connects to a single IP Office Server Edition Primary server.
Avaya Contact Center Select Business Continuity-enabled solutions support connecting to an IP
Office Secondary server. A Small Community Network (SCN) is a system of networked IP Office
telephone systems that can share extension numbers and user names. Each IP Office SCN
supports a single connected Avaya Contact Center Select. The Avaya Contact Center Select
server and the connected IP Office server must be located at the same campus location.

To support an IP Office SCN, Avaya Contact Center Select must connect to an IP Office Server
Edition Primary server in that SCN network.

Avaya Contact Center Select supports only the following versions of IP Office:

• IP Office Server Edition Release 10.1, or 11.x

• IP Office 500V2, Release 10.1, or 11.x software, Standard Mode, Advanced Edition license

Avaya Contact Center Select does not support other versions of IP Office. For more information
about the supported IP Office versions, refer to the Avaya Contact Center Select Release Notes.

Avaya Contact Center Select does not support IP Office 500V2 Basic mode.
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Using IP Office Manager
Before you begin

• Install the IP Office Manager software on a client computer.
• Ensure the client computer can communicate with the IP Office server.

About this task
IP Office Manager is a component of the IP Office administration suite of applications. You use IP
Office Manager to configure IP Office. IP Office Manager runs on a Windows computer and
connects to the IP Office system using an Ethernet LAN connection.
IP Office Manager is an off-line editor. Use IP Office Manager to connect to your IP Office server
and retrieve a local copy of the IP Office current configuration settings. You can then edit the local
copy of the IP Office configuration and when you are ready, save your updated configuration data
back to the IP Office server.

Procedure
1. On the client computer, select Start > All Programs  > IP Office  > Manager.
2. On the Configuration Service User Login message box, in the Service User Name box,

type the user name. The default name is Administrator.

3. In the Service User Password box, type the user password. The default password is
Administrator.

4. From the menu, select File  > Close Configuration. This closes any open and potentially
out-of-date configurations.

5. To retrieve the current (most recent) IP Office configuration settings, from the menu, select
File  > Open Configuration.

6. In the Select IP Office window:

• If the required IP Office server is listed, use the check box to select your IP Office server
from the list of available servers.

• If the required IP Office server is not listed, in the Unit/Broadcast Address box type the
IP address for your IP Office server. Click Refresh to perform a new search. The IP
Office server then appears in the list of available servers. Use the check box to select
your IP Office server from the list of available servers.

IP Office configuration
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7. Click OK.

8. On the Configuration Service User Login message box, in the Service User Name box,
type the user name. The default name is Administrator.

9. In the Service User Password box, type the user password. The default password is
Administrator.

10. IP Office Manager opens and displays the current configuration data for your IP Office
server.

Configuring the data synchronization user account
About this task
Configure the user account used by IP Office to maintain data synchronization with Avaya Contact
Center Select.
For user data synchronization, IP Office connects to Avaya Contact Center Select using the
Contact Center Manager Administration “accssync” user account details.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select System.

Configuring the data synchronization user account
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3. Select the Contact Center tab.

4. From the Contact Center Application list, select Avaya Contact Center Select.

5. In the CCMA Address box, type the IP address of the Avaya Contact Center Select server.
For example, type http://1.2.3.4

Note:

If security is enabled on the Avaya Contact Center Select server, use HTTPS.

6. In the CCMA Username box, type the name of the Avaya Contact Center Select data
synchronization user account. The default user name is accssync.

7. In the CCMA Password box, type the password of the Avaya Contact Center Select data
synchronization user account. The default user password is accssync.

8. Click OK.

IP Office configuration
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Configuring an IP Office service user for data
synchronization

About this task
Create and configure an IP Office service user to support data synchronization with Avaya Contact
Center Select.
Avaya Contact Center Select uses this IP Office service user account to synchronize agent and
supervisor data between Avaya Contact Center Select and the IP Office platform.

Procedure
1. Log in to IP Office Manager with Administrator privileges.

2. Select File > Advanced > Security Settings.

3. On the Service Users list pane, right-click and select New.

4. On the New Service User Details screen, in the New User Name box, type the name for
the new service user.

For example, ACCSData.

5. In the New User Password box, type the password for the new service user.

6. In the Re-enter New User Password box, re-type the password for the new service user.

7. Click OK.

8. On the Service Users list pane, select the new service user.

Configuring an IP Office service user for data synchronization
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9. On the Service User Details pane, from the Rights Group Membership list, select
Business Partner.

10. Click OK.

11. Select File > Save Security Settings.

Verifying the IP Route configuration
About this task
Verify the Local Area Network (LAN) Ethernet and IP Route configuration details to ensure IP
Office can communicate with IP Office Manager, Avaya Contact Center Select, and agent
telephones.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select System.

IP Office configuration
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3. Note the IP Office network settings. Note which network interface IP Office is using for
local communications. For Avaya Contact Center Select deployments, IP Office must use
LAN1 for local communications.

4. In the Configuration pane, under the IP Office server, select IP Route. If there are no
existing IP Routes, right-click IP Route and select New.

5. On the IP Route tab, in the IP Address box, type 0.0.0.0.

6. In the IP Mask box, type 0.0.0.0.

7. In the Gateway IP Address box, type the IP address of your gateway.

8. From the Destination list, select the network interface that IP Office uses for local
communication. For example, select LAN1.

Verifying the IP Route configuration
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9. Click OK.

Configuring the SIP domain name
About this task
Configure the IP Office SIP domain name. A SIP domain is a logical space where SIP-enabled
devices exist, authenticate, register, and communicate.
In a SIP network a destination address consists of both a user and a domain. This is referred to as
a Uniform Resource Identifier (URI). The user portion of the URI is the destination that is being
communicated to and the domain portion is the logical grouping that the destination belongs to.

Important:
If you add or change the domain name of an active IP Office server, the IP Office server
restarts.

The Avaya Contact Center Select SIP domain name must match the IP Office SIP domain name.

IP Office configuration
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Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select System.

3. In the right pane, select the LAN1 tab.

4. Select the VoIP tab.

5. Enable SIP Registrar Enable.

6. In the Domain Name box, type the name of the SIP domain to be used with Avaya Contact
Center Select.

7. Click OK.

Configuring the SIP domain name
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Configuring the SIP User Extension number
About this task
Configure an IP Office SIP User Extension number for desk phones and softphones. Avaya
Contact Center Select uses this SIP User Extension number and Telephony Supervisor Login
Code password to register for CTI call control and SIP session messaging.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select User.
3. Right-click on User, and select New.

4. In the right pane, select the new User tab.

5. In the Name box, type a descriptive name for the user.

6. In the Password box, type a password for the user.

The password can be up to 31 alphanumeric characters long. Password complexity rules
are set through the General security settings.

7. In the Confirm Password box, re-type a password for the user.

8. In the Extension box, type the extension number of the user. For example, type 6000.

For desk phones, the Extension value must match the Base Extension value of a phone.
For more information, see Configuring IP Office extensions on page 34.

9. Select the Telephony tab.

10. On the Telephony tab, on the Supervisor Settings sub-tab, in the Login Code box, type
a password for Avaya Contact Center Select registration. For example, type 123456. This
password must be a number.

11. Click OK.

12. On the Would you like a new VoIP extension created with this number message box,
select SIP Extension and click OK.

Configuring a short code for Contact Center Route Points
About this task
Configure a solution short code to map an IP Office telephone number to the Avaya Contact
Center Select SIP User Extension Number. A short code configures IP Office to perform an action
if a specific number is dialed.
For example:

• 3000 is configured in Avaya Contact Center Select as a CDN (Route Point).

IP Office configuration
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• 6000 is configured in IP Office as the Avaya Contact Center Select SIP User Extension
Number.

Create a short code 6000|>>3000. All customer calls to telephone number 3000 are forwarded to
extension 6000 and from there to Avaya Contact Center Select. Avaya Contact Center Select can
then treat the customer call and route it to a contact center agent.
This task describes a basic IP Office short code used to route calls to Avaya Contact Center
Select. For information about implementing production grade short codes, refer to your IP Office
documentation.
A CDN (Route Point) is a logical address used by Contact Center to accept incoming contacts or
as a point to which contacts are routed. A Route Point is an address that enables incoming voice
contacts (phone calls) to be treated by Contact Center.
You can add multiple short codes and configure each one to map to an Avaya Contact Center
Select CDN (Route Point) number. If you create additional short codes to map IP Office calls to
Avaya Contact Center Select, you must add the corresponding CDN (Route Point) number in
Contact Center Manager Administration on the Avaya Contact Center Select server.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the Solution node, select Short Code, right-click and
select New.

3. In the right pane, in the Code box, type a CDN (Route Point) number. When this number is
matched, the other short code fields activate. For example, type 3000, where 3000 is an
Avaya Contact Center Select CDN (Route Point).

4. From the Feature list, select Dial Extn. If you do not see the Dial Extn option, ensure that
you have selected the Short Code menu item under Solution, and not the local Short
Code menu item for your IP Office. The Solution Short Code is common to all systems.

5. In the Telephone Number box, type the number output by the short code. For example,
type the following: 6000|>>3000
• Where 3000 is configured in Avaya Contact Center Select as a CDN (Route Point).

• Where 6000 is the Avaya Contact Center Select SIP User Extension Number.

Note: Ensure there are no spaces in the Telephone Number box.

If a customer dials 3000, then 3000 is sent to telephone number 6000 and Avaya Contact
Center Select.

Configuring a short code for Contact Center Route Points
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6. Click OK.

Configuring Contact Recording
Before you begin

• Ensure the Media Manager application is installed, configured, and working on your IP Office.

About this task
Configure the User and User Rights settings to enable Contact Recording for Avaya Contact
Center Select agents and agent supervisors using IP Office.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the Solution node, select User Rights.

3. In the middle pane, select Application.

4. In the right Application pane, select the User tab.

IP Office configuration
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5. Select Application Servers Group.

6. Click OK.

7. In the right Application pane, select the Forwarding tab.

8. Select Enable Block Forward.

9. From the list, select Apply User Rights value.

Configuring Contact Recording
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10. Click OK.

11. Using IP Office Manager, select the IP Office server in the Configuration pane.

12. In the Configuration pane, under the IP Office server, select User.
13. In the middle pane, select the Avaya Contact Center Select SIP User Extension.

14. In the right pane, select the User tab.

15. From the Working hours Users Rights list, select Application.

IP Office configuration
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16. Click OK.

17. On the Avaya Contact Center Select SIP User Extension user, select the Voice Recording
tab.

18. From the Inbound list, select None.

19. From the Outbound list, select On, and Internal.

Configuring Contact Recording
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20. From the Destination list, select Voice Recording Library.

21. Click OK.

Configuring IP Office extensions
About this task
Use this procedure to configure an IP Office extension for Avaya Contact Center Select agents
using SIP and H.323 physical desk phones.

Important:
Use this procedure for desk phones only. Ignore this procedure if your Avaya Contact Center
Select agents use Avaya Communicator or Avaya Workplace Attendant softphones for
Windows with IP Office. Avaya Contact Center Select prevents creating an IP Office extension
for an extension used by a softphone and prohibits using the same extension for a physical
desk phone and a softphone.

When you create an agent in Avaya Contact Center Select, data synchronization ensures that a
corresponding user is created in IP Office. For Avaya Contact Center Select agents using SIP and
H.323 physical desk phones, IP Office must have an extension for every IP Office user. You can
reuse existing IP Office extensions for this purpose. Alternatively, you must create one new IP
Office extension for each IP Office user that corresponds to an Avaya Contact Center Select
agent. Avaya Contact Center Select agents can then use these IP Office users and extensions to
handle customer calls when they log on.
There are many different ways of providing a H.323 or SIP IP Office extension for each Avaya
Contact Center Select agent, the following procedure describes one method. Some IP Office

IP Office configuration
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Extension settings cannot be merged. Changes to these settings might require a reboot of the IP
Office system.

Important:
If your Avaya Contact Center Select agents are using Avaya Communicator for Windows with
IP Office, do not create an extension for the corresponding IP Office users.

Procedure
1. Using IP Office Manager, select the IP Office server in the Configuration pane.

2. In the Configuration pane, under the IP Office server, select Extension.

3. Right-click and select New  > H323 Extension or select New > SIP Extension.

4. On the Extn tab, in the Extension Id box, type an extension number.

The Extension ID is the physical ID of the extension port. IP Office Manager prepopulates
the default value.

5. On the Extn tab, in the Base Extension box, type a base extension number.

The Base Extension is the extension number associated with the phone, that is the internal
number you must dial to reach a user.

The Base Extension value must match the Extension value of a user. For more
information, see Configuring the SIP User Extension number on page 28.

6. In the Phone Password box, type a password.

The password is only required for the H.323 extensions if you enable Media Security. For
more information, refer to the IP Office documentation.

7. In the Confirm Phone Password box, retype the password.

8. Click OK.

9. Ensure the IP Office server has an extension, with a configured base extension number, for
every IP Office user that corresponds to an Avaya Contact Center Select agent.

Saving the IP Office configuration data
Before you begin

• Install the IP Office Manager software on a client computer that can communicate with the IP
Office server.

About this task
Use IP Office Manager to save your configuration changes to the IP Office server.

Procedure
1. In IP Office Manager, in the Configuration pane, select your IP Office server.

Saving the IP Office configuration data
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2. From the main IP Office Manager menu, select File > Save Configuration.

3. On the Send Multiple Configurations window, use the check box to select your IP Office
server from the list.

4. Click OK.

IP Office Manager saves the offline configuration file to your IP Office server.

IP Office configuration
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Chapter 5: Deploying Avaya Aura® Media
Server on Microsoft Azure

Create a Linux server image on Microsoft Azure and deploy a standalone Avaya Aura® Media
Server as a software application. Use the Avaya Aura® MS software installer to install and configure
the media server application.
Avaya Aura® Media Server on Microsoft Azure supports only Red Hat Enterprise Linux (RHEL)
Release 7.6.

Avaya Aura® Media Server virtual machine requirements
for Microsoft Azure

To deploy Avaya Aura® Media Server on Microsoft Azure, ensure that your virtual machine meets
the following specification:

AMS virtual machine requirements for Microsoft Azure
Component Minimum Typical High Capacity
VM Size* StandardB2s StandardF4sv2 StandardA4
VM Generation V1
RHEL version Red Hat Enterprise Linux (RHEL) Release 7.6
Disk type Standard HDD
Disk size (GB) 80

Note:

The VM size depends on the CPU core and RAM combination. Avaya recommends that you select
higher configuration on Microsoft Azure.

Creating a virtual Linux server
About this task
Create a virtual machine with the Linux server to install the Avaya Aura® Media Server.
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Avaya Aura® Media Server on Microsoft Azure supports only Red Hat Enterprise Linux (RHEL)
Release 7.6.

Procedure
1. In the Microsoft Azure portal, click Virtual machines.

2. On the Virtual machines screen, click Create > Virtual machine.

3. On the Basics tab, do the following:

a. From the Resource group list, select the resource group you have created for your
solution.

b. From the Image list, select the RHEL 7.6 server.

Tip:

If you cannot find the required server name in the list, click See all images and
use the Search the Marketplace box to find the server.

c. Under Administrator account, select Password as an authentication type and
configure a username and a password.

d. Fill in the other required fields.

4. Click Review + create.

5. Click Create.

6. When the deployment process is finished, on the virtual machine Overview screen, click
Stop to shut down the created Linux server.

7. In the left pane, under Settings, click Disks.

8. Under OS disk, click the OS disk name.

The OS disk Overview screen opens.

9. In the left pane, under Settings, click Size + performance.

10. In the Custom disk size (GiB) box, type 80.

11. Click Resize.

12. On the virtual machine Overview screen, click Start to launch the Linux server.

Configuring the disk partitions
About this task
Configure the disk partitions of your virtual Linux server.

Before you begin
Ensure that you are connected to VPN.

Deploying Avaya Aura® Media Server on Microsoft Azure
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Procedure
1. Connect the Linux server using through SSH using the private IP address of the server.

You can use PuTTY or other clients.

2. Log in to the Linux server as the root user.

3. To manage the disk partitions, run the following command:sudo fdisk/dev/sda.

4. To change the display units, run the following command: u.

5. To display the current partition table, run the following command: p.

The table displays that the disk has two partitions.

6. To delete a partition, run the d command.

7. Press Enter to delete the second partition.

8. To add a new partition, run the following command: n.

9. To select the default partition type, press Enter.
10. To select the default partition number, press Enter.
11. To select the default first cylinder value, press Enter.
12. To select the default last cylinder value, press Enter.
13. To set a bootable flag, run the a command and press Enter to select the default value.

14. To save the changes and exit, run the following command: w.

See the following screenshot as an output example:

Configuring the disk partitions
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15. When the server is up, run the xfs_growfs -d /dev/sdaX command, where X is the
partition number.

For example, xfs_growfs -d /dev/sda2.
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Installing the Avaya Aura® Media Server software on the
virtual Linux server

About this task
Transfer the Avaya Aura® MS installer from your local machine to the virtual Linux server using
WinSCP and install the Avaya Aura® Media Server application using the SSH console.

Before you begin
• Ensure that you are connected to VPN.
• Install WinSCP on your local machine.
• Download the Avaya Aura® MS software from the Avaya Product Licensing and Delivery

System (Avaya PLDS) at https://plds.avaya.com.
• Log in to the Linux server using the SSH console.

Procedure
1. Use WinSCP to copy the Avaya Aura® MS software installer to the Linux server on

Microsoft Azure.

2. Using the SSH console, change the current directory to the location of the transferred
Avaya Aura® MS installer or the drive where the Avaya Aura® MS installation file resides.

The name of the file is in the following format:
MediaServer_8.0.build_yyyy.mm.dd.bin.

3. To apply executable permissions to the installer file, run the chmod 755 filename
command, where filename is the name of the Avaya Aura® MS installation file.

4. To update all packages, run the following command: sudo yum update.

5. To confirm the package installation, type y.

6. To run the installer, run the following command ./filename, where filename is the
name of Avaya Aura® Media Server installer.

For example, ./MediaServer_8.0.2.93_2020.01.30.bin.

7. To confirm the package installation, type y.

8. When prompted, press Enter.
9. Enable the https port from the server firewall or disable the firewall by doing the following:

• To know the status of firewall, type systemctl status firewalld.

• To disable firewall, type systemctl disable firewalld.

• To stop firewall, type systemctl stop firewalld.
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Logging on to Avaya Aura® Media Server Element Manager
About this task
Log in to Avaya Aura® Media Server Element Manager to configure Avaya Aura® Media Server.
Element Manager (EM) is a web-based administration tool that facilitates the Operation,
Administration, and Maintenance (OAM) of Avaya Aura® Media Server.

Note:
You must have more than one Avaya Aura® Media Server account managed by separate
users. If one account is disabled or lost, another account can perform critical tasks, backups
or recovery. For more information, see Implementing and Administering Avaya Aura® Media
Server.

Procedure
1. On your client computer, start a Web browser.

2. In the address box, enter https://SERVER_IP_ADDRESS:8443/em. Where
SERVER_IP_ADDRESS is the IP address of the Avaya Aura® Media Server.

3. In the User ID box, type the Avaya Aura® Media Server User ID log in account name. For
example, type Admin.

4. In the Password box, type the account password.

5. Click Sign In.

Configuring Avaya Aura® Media Server name resolution
About this task
Configure Avaya Aura® Media Server to resolve the hostname and Fully Qualified Domain Name
(FQDN) of the Contact Center Manager Administration server. The Contact Center Manager
Administration (CCMA) software is installed on the Contact Center server.

Procedure
1. Log in to Element Manager with administrative privileges.

2. Navigate to EM > System Configuration > Network Settings > Name Resolution.

3. Click Add.

4. In the IP Address box, enter the Contact Center Manager Administration IP address.

5. In the Hostname box, enter the Contact Center Manager Administration hostname.

6. Click Save.
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Adding Contact Center Manager Administration as a SOAP
trusted node

About this task
To support Prompt Management in Contact Center Manager Administration (CCMA), you must
add CCMA as a SOAP trusted node in Avaya Aura® Media Server Element Manager.

Procedure
1. Log in to Element Manager.

2. In the Element Manager navigation pane, click System Configuration > Network
Settings > General Settings.

3. Click SOAP.

4. In the Trusted Nodes box, enter the IP address of the CCMA server.

5. Select Enable Trusted SOAP Nodes.

6. Click Save.
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Chapter 6: Deploying Avaya WebLM

Avaya provides a Avaya WebLM to manage licenses of one or more Avaya software products for
your organization. WebLM facilitates easy tracking of licenses. To track and manage licenses in an
organization, WebLM requires a license file from the https://plds.avaya.com website.
To deploy Avaya WebLM on Microsoft Azure, contact the Avaya representative and request to
create an Avaya WebLM OS disk on Microsoft Azure. When the disk is available on your
subscription, you can create a virtual machine from this disk.

Creating the Avaya WebLM virtual machine on Microsoft
Azure

About this task
Create a virtual machine for Avaya WebLM from the Avaya WebLM OS disk.

Before you begin
• Contact Avaya and request to create a managed disk with the Avaya WebLM OS.

Procedure
1. Log in to the Microsoft Azure portal: https://portal.azure.com/.

2. Click Disks.

3. From the list, select the Avaya WebLM OS disk.

4. Click Create VM and do the following:

a. In Resource Group, select the resource group that you created for IP Office.
b. In Virtual machine name, type the virtual machine name.
c. In Size, select the required virtual machine size.
d. In Authentication type, select Password.
e. Verify the network subnets.
f. Click Review + Create.

g. Click Create.

Result
You now can connect the Avaya WebLM virtual server using VPN.
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Obtaining the WebLM server Host ID
Before you begin

• Deploy the WebLM OVA on your VMware host server.

About this task
Obtain the WebLM server Host ID so you can use it to obtain or generate a license for use by
Contact Center features.
The first time you log in to the WebLM Web interface, you must change the default password.

Procedure
1. Open Internet Explorer and enter the following URL:

https://<WebLMIPAddress>:52233/WebLM/index.jsp

Where WebLMIPAddress is the IP address of the WebLM virtual machine.

2. Log in to the Web License Manager user interface using the default settings:

The default User Name is admin.

The default Password is weblmadmin.

3. Click Log On.

4. You are forced to change the password and log back on again using the new password.

5. On the left hand pane, select Server properties.
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6. Record the Server Host ID Primary Host ID number.

7. Use the WebLM server Host ID to obtain Contact Center licenses from the Avaya Product
Licensing and Delivery System (PLDS).

Installing the WebLM license file
Before you begin

• Use the WebLM server Host ID to obtain Contact Center licenses from the Avaya Product
Licensing and Delivery System (PLDS).

About this task
Install the WebLM license file to license Contact Center features and agents.

Procedure
1. Open Internet Explorer and enter the following URL:

https://<WebLMIPAddress>:52233/WebLM/index.jsp

Where WebLMIPAddress is the IP address of the WebLM virtual machine.

2. Log in to the Web License Manager user interface using the “admin” User Name and your
new password.

3. Log in to the WebLM Web interface using your new password.

4. In the left hand pane, click Install license.

5. In the Enter license path box, enter the license file details. Alternatively, click Browse to
load the license file.
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6. Click Install.
7. You can review the Contact Center licensed details by clicking Licensed products >

CCTR > ContactCenter.

WebLM licensing is now available for Contact Center.
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Chapter 7: Avaya Contact Center Select
installation

On the Microsoft Azure portal, create and configure the Microsoft Windows Server virtual machine,
install the Avaya Contact Center Select application software from an ISO image, and configure
Avaya Contact Center Select using the Ignition Wizard, a simple configuration utility.

Avaya Contact Center Select Release 7.1 is supported only on the Microsoft Windows Server 2012
R2 or Microsoft Windows Server 2016 operating system. The Microsoft Windows Server 2012 R2 or
Microsoft Windows Server 2016 operating system and server must meet the requirements specified
in Avaya Contact Center Select Solution Description. Avaya Contact Center Select supports only
Standard or Data Center editions of Microsoft Windows Server 2012 R2 or Microsoft Windows
Server 2016.

Creating the Windows Server virtual machine on Microsoft
Azure

About this task
Create a Windows Server 2012 R2 or Windows Server 2016 virtual machine on Microsoft Azure to
deploy Avaya Contact Center Select.

Before you begin
• Ensure that the resource group and virtual network (VNET) that you created are available.
• Read Avaya Contact Center Select Solution Description for the Avaya Contact Center Select

server specification requirements.

Procedure
1. In the Microsoft Azure portal, click Virtual machines.

2. On the Virtual machines screen, click Create > Virtual machine.

3. On the Basics tab, do the following:

a. From the Resource group list, select the resource group you have created for your
solution.

b. From the Image list, select Windows Server 2012 R2 or Windows Server 2016.
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Tip:

If you cannot find the required server name in the list, click See all images and
use the Search the Marketplace box to find the server.

c. Fill in the other required fields.

4. Click Review + create.

5. Click Create.

6. When the deployment process is complete, stop the virtual machine.

7. Configure the virtual machine size to comply with the Avaya Contact Center Select server
specification requirements.

The server must have minimum 32 GB RAM.

8. Create and attach a new SSD data disk with the size required for your solution.

9. Save the changes and start the virtual machine.

Configuring the Windows Server 2016 virtual machine
About this task
Configure the Windows Server 2016 virtual machine created on Microsoft Azure to deploy Avaya
Contact Center Select.
For more information about hard disk partitions, see Avaya Contact Center Select Solution
Description.

Before you begin
• Ensure that you are connected to the Azure VPN.

Procedure
1. Connect to the Windows virtual machine using the private IP address.

2. In the network settings, assign a static IP address to the server.

Avaya Contact Center Select servers do not support Dynamic Host Configuration Protocol
(DHCP).

3. If the Windows virtual machine uses letter D as the temporary disk name, use the Microsoft
Azure instruction to change the drive letter.

See the instruction at https://docs.microsoft.com/en-us/azure/virtual-machines/windows/
change-drive-letter.

4. In the search box, enter diskmgmt.msc to access Disk Management.

5. Initialize the data disk and perform the disk partition as required for Avaya Contact Center
Select.
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Next steps
Mount the Avaya Contact Center Select ISO image and use the Avaya Contact Center Select
installer and the Ignition Wizard to install and configure Avaya Contact Center Select.

Installing Avaya Contact Center Select without Avaya
Aura® Media Server Release 7.1 DVD software

About this task
Install the Avaya Contact Center Select without Avaya Aura® Media Server software and enable
your contact center to route contacts to the agents.

Before you begin
• Download the Avaya Contact Center Select ISO image and patches from the Avaya Product

Licensing and Delivery System (Avaya PLDS) at https://plds.avaya.com.
• Download the most recent Avaya Contact Center Select Release Notes.

Procedure
1. Read the Avaya Contact Center Select Release Notes for the most recent instructions.

2. Mount the Avaya Contact Center Select ISO file in your virtual machine so that it is
available as a DVD drive.

3. Double click the DVD drive on the virtual server.

If the installation does not automatically start, access the DVD drive and double-click
Setup.exe.

4. Click Install to install the necessary software libraries on the server.

If you are prompted to accept the Microsoft .NET Framework license agreement, click
Accept. If you are prompted to restart the server, click Yes.

5. After the prerequisite software and libraries are installed, navigate to the Avaya Contact
Center Select DVD and double-click Setup.exe to install the application software.

6. The Avaya Contact Center Select installer starts and verifies that the server meets the
minimum hardware and Operating System requirements:

• If the system checker detects server errors, it displays a System information window
listing the detected blocking issues. Review the displayed issues, click Cancel, and
consult Avaya Contact Center Select Solution Description to determine the actions to
resolve the issue.

• If the system checker detects non-blocking warnings, it displays a System information
window listing the detected issues. Review the displayed issues and consult Avaya
Contact Center Select Solution Description to determine the actions to resolve the issue.
You can ignore warnings if the potential impact to the operation of the contact center is
understood and not applicable. Click Ignore or Cancel.

Avaya Contact Center Select installation

April 2022 Deploying Avaya Contact Center Select on Microsoft Azure 50
Comments on this document? infodev@avaya.com

https://plds.avaya.com
mailto:infodev@avaya.com?subject=Deploying Avaya Contact Center Select on Microsoft Azure


• If the system checker does not detect issues, the System information window is not
displayed.

7. On the Select Deployment Type screen, select Avaya Contact Center Select without
Avaya Aura® Media Server.

8. Click Next.
9. The Select Destination Drive window appears.

10. From the Journal Database Drives list, select the drive for the database journal file.

11. From the Voice Contact Server Database Drive list, select the drive for the voice
databases.

12. From the Multimedia Contact Server Database Drive list, select the drive for the Contact
Center Multimedia database.

13. In the Service Packs section, browse to locate the folder containing the Avaya Contact
Center Select product updates.

14. Click Install.
15. The AVAYA GLOBAL SOFTWARE LICENSE TERMS window appears.

Installing Avaya Contact Center Select without Avaya Aura® Media Server Release 7.1 DVD software
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16. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
17. The MICROSOFT SOFTWARE LICENSE TERMS window appears.

18. Read the terms of the license.

• If you accept the terms, click I ACCEPT THE LICENSE TERMS. The installation
continues.

• If you do not accept the terms, click I DECLINE THE LICENSE TERMS. The installation
returns to the Select Destination Drive screen. Click Cancel to stop the install.

• To print the license terms, click Print.
19. The Progress window appears and displays the installation progress.

20. After a successful installation, the following window appears.
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21. When the software is installed, you have the following options.

• To continue configuring the server installation data:

a. Select the Launch Avaya Contact Center Select Ignition Wizard check box.

b. Click Configure. This starts the Avaya Contact Center Select Ignition Wizard.

• To defer configuring the server installation data:

a. Clear the Launch Avaya Contact Center Select Ignition Wizard check box.

b. On the message box, click Yes.

c. On the main installer screen, click Close.

d. Follow the on-screen instructions and shut down the Avaya Contact Center Select
server.

You must use the Ignition Wizard to initialize Avaya Contact Center Select, otherwise
Avaya Contact Center Select is not operational. For more information about the Ignition
Wizard, see the following procedures.

Next steps
Use the Ignition Wizard to configure Avaya Contact Center Select.

Configuring the server installation data
Before you begin

• Know the IP address of the IP Office primary call server.
• Know the IP Office Service User account name and password.
• Know the IP Office System Password. Ask your IP Office Administrator for the System

Password.
• Configure an IP Office SIP User Extension Number to be used to register Avaya Contact

Center Select.
• Configure an IP Office short code to forward customer calls to an Avaya Contact Center

Select CDN (Route Point).
• Install an Avaya WebLM server. Know the IP address and port number of the Avaya WebLM

server.
• Install an Avaya Aura® Media Server server. Know the IP address and port number of the

Avaya Aura® Media Server server.
• If your Avaya Contact Center Select solution is going to support email contacts, configure the

mailbox details on your email server that you use to receive inbound email messages
intended for the Avaya Contact Center Select. Know the name and password for this
mailbox.

• If your Avaya Contact Center Select solution is going to support email contacts, know the
host name of your email host server.

Configuring the server installation data
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• You must configure the required language and locale of the Contact Center server operating
system, if it is not a Latin-1 language, before configuring the Contact Center server using the
Contact Center Ignition Wizard. For more information about configuring language and locale
settings on the Contact Center server, see Avaya Contact Center Select Advanced
Administration.

About this task
Configure the Avaya Contact Center Select installation data to enable communication with an IP
Office primary call server.
Optionally, if your solution is to support routed email contacts, configure the mailbox details on
your email server that you use to receive inbound email messages intended for the Avaya Contact
Center Select. Avaya Contact Center Select logs onto this mailbox on your mail server and
retrieves email at defined intervals. Email messages are then routed to agents. To route an email,
Avaya Contact Center Select requires the mailbox name and password.

Procedure
1. Log on to the Avaya Contact Center Select server using the Administrator account details.

The Avaya Contact Center Select Welcome screen appears.

2. Click Next.
3. On the license screen, select I Accept the Terms of the End-User License Agreement.
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4. Click Next.

5. On the Configuration Data screen, select the IP Office tab.

6. In the IP Office Server section, in the IP Address box, type the IP address of the IP Office
primary call server.

7. In the Voice Port box, type the port number of the IP Office primary call server. The default
port number is 5060.

8. From the Transport list, select the network transport communication protocol for the IP
Office primary call server. The default protocol is TCP.

9. In the IP Office SIP Domain Name box, type the SIP domain name of your IP Office
primary call server. The Avaya Contact Center Select SIP domain name must match your
IP Office SIP domain name.

10. In the IP Office SIP Extension section, in the Extension Number box, type the IP Office
SIP User Extension Number used to register Avaya Contact Center Select. For more
information, see Configuring the SIP User Extension Number on page 28.

11. In the IP Office SIP Extension section, in the Password box, type the password of the IP
Office SIP User Extension Number used to register Avaya Contact Center Select. Enter the
number that you configured for the Supervisor Settings - Login Code on the user’s
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Telephony tab. For more information, see Configuring the SIP User Extension Number on
page 28.

12. In the IP Office SIP Extension section, in the Confirm Password box, re-type the
password.

13. In the IP Office Service User section, in the Username box, type the name of your IP
Office data synchronization service user. For more information, see Configuring an IP
Office service user for data synchronization on page 23.

14. In the IP Office Service User section, in the Password box, type the password of your IP
Office data synchronization service user.

15. In the IP Office Service User section, in the Confirm Password box, re-type the
password.

16. In the IP Office System Password section, in the Password box, type the System
Password for your IP Office call server. Ask your IP Office Administrator for the System
Password.

17. In the IP Office System Password section, in the Confirm Password box, re-type the
System Password for your IP Office call server.

18. Select the Sample Data tab.
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19. In the Contact Center Sample Data section, in the Sample Agent Starting ID box, type a
phone number for the first sample Avaya Contact Center Select agent. Avaya Contact
Center Select automatically creates ten sample agents, using this number as the first of
ten sequential agent numbers. The default number is 6001.

20. In the Sample CDN (Route Point) box, type a number for the Avaya Contact Center
Select CDN (Route Point). This number must match an IP Office short code entry number.
For more information, see Configuring a shortcode to Contact Center Route Points on
page 28. The default number is 3000.

21. In the Callback Mailbox Number box, type the voice mail mailbox number. This voice mail
number is used by the Customer Service sample application in Orchestration Designer.
The default number is 6999.

22. In the Sample Agent’s Password section, in the Password box, type a password for the
Windows accounts of the sample agents. Avaya recommends that you enter a password
that conforms to your corporate password policy.

23. In the Confirm Password box, re-type the password for the Windows accounts of the
sample agents.

24. Select the Core tab.

25. In the Avaya Aura® Media Server section, in the IP Address box, type the IP address of
your Avaya Aura® Media Server.
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26. In the Port box, type the port number for your Avaya Aura® Media Server. The default port
number is 5060.

27. From the IP Office Contact Center Media Services Locale list, select the locale
(including language and dialects) of the solution environment.

28. In the System Account Configuration section, in the Password box, type a password for
the Avaya Contact Center Select administration account. The password is not checked
against the server security policy for minimum password requirements. Avaya
recommends that you enter a password that conforms to your corporate password policy.

29. In the Confirm Password box, type the password.

30. Select the Licensing tab.

31. From the License Type list, select Remote WebLM.

32. In the IP Address box, type the IP address of the remote Avaya WebLM server.

33. (Optional) To configure the Avaya WebLM centralized licensing, select the Centralized
check box and, in the CLID box, type the Centralized License ID (CLID) of the ACCS
server.

34. Select the Multimedia tab.
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35. In the Mailbox Configuration section, from the Mail Provider list, select None, Microsoft
Exchange, Gmail, Outlook Hotmail, Yahoo, or Other (POP3/IMAP). The default is Microsoft
Exchange. If Avaya Contact Center Select is not going to process email contacts, select
None. If you select Gmail, Outlook Hotmail, or Yahoo, the Incoming Mail Server and
Outgoing Mail Server sections are automatically populated for you.

36. In the Mailbox Configuration section, in the Display Name box, type a display name for
the mailbox.

37. In the Mailbox Configuration section, in the Email box, type the email address for the
mailbox. For example, sales@company.com.

38. In the Mailbox Configuration section, in the Password box, type the password for the
mailbox.

39. In the Mailbox Configuration section, in the Confirm Password box, re-type the
password for the mailbox.

40. In the Incoming Mail Server section, in the Host Name box, type the name of the server
on which email messages are received in your network.

41. In the Incoming Mail Server section, from the Protocol list, select the communication
protocol for the inbound email server. Select POP3 or IMAP. The default protocol is POP3.
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42. In the Incoming Mail Server section, from the Encryption list, select the encryption type
to use. Select Cleartext, TLS, or STARTTLS.

43. In the Incoming Mail Server section, in the Port box, type the port number of the
incoming email server. For the POP3 protocol, the default port number is 110. For the
IMAP protocol, the default port number is 143.

44. In the Outgoing Mail Server section, in the Host Name box, type the name of the server
from which email messages are sent. Your inbound and outbound mail servers can have
the same name.

45. For outgoing email, the Protocol is SMTP.

46. In the Outgoing Mail Server section, from the Encryption list, select the encryption type
to use. Select Cleartext, TLS, or STARTTLS.

47. In the Outgoing Mail Server section, in the Port box, type the port number of the outgoing
email server. The default port number is 25.

48. In the Outgoing Mail Server section, from the SMTP Authentication list, select SMTP
Authentication Disabled or Base 64 Encoded Authentication. The default authentication
method is Base 64 Encoded Authentication.

49. Select the Security Configuration tab, and configure the security details in the Security
Store Details section.
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50. If you do not want to enable security, select the Skip Security Configuration checkbox
and skip to 66 on page 63.

Important:

A warning message appears. If you proceed without enabling security and IP Office is
using TLS, you cannot test a first call quickly without additional configuration steps.
The CTI link is disabled until you configure Contact Center TLS certificates to
communicate securely with IP Office, or until you configure IP Office to allow an
unsecured CTI connection. After the deployment, to complete your security
configuration, follow the procedures in Avaya Contact Center Select Advanced
Administration.

51. In the Full Computer Name (FQDN) box, type the full FQDN of the server on which you
are creating the security store.

Important:

The FQDN must be the full machine name of the server that the Security Store resides
on. The FQDN name is case-sensitive.

52. In the Name of Organizational unit box, type the name of the department or division
within the company.

53. In the Name of Organization box, type the company name.

54. In the City or Locality box, type the name of the city or district in which the contact center
is located.

55. In the State or Province box, type the state or province in which the contact center is
located.

56. In the Two Letter Country Code box, type the country code in which the contact center is
located.

57. In the Security Store password box, type a password for accessing the new security
store.

58. In the Confirm Store password box, confirm the password for accessing the new security
store.

Important:

Ensure you remember this password, because you need it when you log on to Security
Manager after install. If you forget the password, you cannot access Security Manager.

59. If you are implementing High Availability in the contact center, generate the security store
using Subject Alternative Names (SANs). In the Subject Alternative Name section, for
each SAN you want to add:

a. From the Type drop-down list, select DNS.

b. In the Value field, type the FQDN for the server.

c. Click Add.
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For a Business Continuity system, add the current server FQDN and the Managed name
for the HA pair.

60. If you want to change the encryption setting, select the required encryption settings from
the Encryption Algorithm Level and Key Size drop-down lists.

The default value for Encryption Algorithm is SHA256 and the default value for Key Size
is 2048.

Contact Center displays a warning message if you select SHA1 or 1024. Contact Center
includes these values for backward-compatibility only, because these settings do not meet
the industry-recommended level of encryption.

61. Click Create Store.

62. You can now use the Security Configuration tab to create and save a Certificate Signing
Request (CSR) file.

63. Click Create CSR File.

64. From the Save In drop-down list, select a shared location in which to save the CSR file
and click Save.

You must now send the Certificate Signing Request file to a Certificate Authority and
receive a signed certificate and root certificate to import to the security store.
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65. Click Add to import certificates. In the Open dialog box, navigate to the location of a
certificate and click Open. To remove the imported certificate, select the required certificate
from the list and click Remove.

You can import either a chained certificate, or separate root and signed certificates. Root
certificates appear in the Imported Trusted Certificate Authority Root Certificate(s)
section. A signed certificate appears in the Imported Identity Security Certificate
section.

If a chained certificate contains both root and signed certificates, you can add root
certificates and signed certificate simultaneously by importing just one chained certificate.

If a chained certificate contains root certificates only, you can use the chained certificate to
add all root certificates at a time. To add a signed certificate, click Add and navigate to the
required signed certificate.

If you have separate root and signed certificates, you must add them one by one by
clicking the Add button. Always add a signed certificate last.

Important:

When adding a chained certificate, the system can ask you to enter the password you
created for accessing the security store. See 57 on page 61.

66. Click Next.
67. Review and confirm your inputs, and click Configure.

The configuration utility begins to configure the Avaya Contact Center Select components.

68. When the Avaya Contact Center Select is configuration details are applied, the
Configuration Complete screen appears.

69. Click Finish.

70. On the Avaya Contact Center message box, click OK to restart Avaya Contact Center
Select.

Avaya Contact Center Select software is now installed on the virtual machine.

Using the Contact Center Dashboard
About this task
You can use the Contact Center Dashboard to access Contact Center system tools and diagnose
system problems. The Contact Center Dashboard displays some Operating System and system
details such as CPU type, network details, and Operating System activation status.
The Contact Center Dashboard launches automatically the first time the Contact Center server
boots up.

Using the Contact Center Dashboard

April 2022 Deploying Avaya Contact Center Select on Microsoft Azure 63
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Contact Center Select on Microsoft Azure


Procedure
1. The Contact Center Dashboard Welcome message box automatically appears when the

server starts up.

2. Click OK.

3. On the Contact Center Dashboard, select the Home tab.

4. Click Refresh All to refresh the Contact Center Dashboard status reports.
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5. In the Avaya Contact Center Status section, click View Services to monitor the state of
the Contact Center Windows services.

6. In the Avaya IP Office Server Availability section, click SIP Gateway Monitor to
determine if Contact Center is communicating with IP Office.

7. Select the Connectivity tab.

8. In the SIP Gateway Monitor section, click Launch to monitor the status of the SIP
connection to IP Office.

9. In the Contact Center Multimedia Dashboard section, click Launch to monitor the
multimedia mailbox status.

10. In the Contact Center Manager Administration section, click Launch to access Contact
Center Manager Administration to configure and manage Contact Center resources.

11. In the System Control and Monitoring Utility section, click Launch to monitor, stop, and
start Contact Center services.

12. In the Contact Center License Manager section, click Launch to monitor license status
and add additional licensed features.

13. Select Business Continuity Support to configure the Business Continuity feature.
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14. Select the Software tab.

15. Contact Center Version displays the version of the Contact Center software installed on
the server.

16. Avaya Aura® Media Server displays the version of Avaya Aura® Media Server software
installed on the server.

17. Ignition Status displays the Contact Center software installation status.

18. Avaya Contact Center Components displays the Contact Center software and patch line-
up installed on the server.

19. Third Party Software Information displays the versions of the third-party software
components used by Contact Center that are installed on the server.
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20. Select the System tab.

21. Machine Name displays the host name of the Contact Center server.

22. Windows Domain displays the name of the domain that the Contact Center server is in.

23. Operating System displays the Operating System version.

24. Windows Activation Status displays the Windows Operating System license and
activation status.

25. RAM displays the amount of RAM memory in the server.

26. CPU displays the type of CPU in the server.

27. Network displays the networking details of the server: IP address and MAC address.

28. Hard Disks displays the number, size, and drive letter of the hard disk volumes in the
server.
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29. Select the Troubleshooting tab.

30. Select System Errors to access Contact Center events in the Microsoft Windows Event
Viewer.

31. Select Contact Center Log Files to access Contact Center trace log files.

32. Select Server Configuration to configure Contact Center licensed features and IP Office
voice network settings.

33. Select Contact Center Documentation to access and download the most recent Contact
Center documentation from the Avaya support website.

Configuring IP Office for unsecured CTI connections
About this task
When you skip security configuration during Avaya Contact Center Select installation, by default
Avaya Contact Center Select uses TCP for the CTI connection to IP Office. You cannot test a first
call quickly until you configure IP Office to allow an unsecured CTI connection.
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If Avaya Contact Center Select uses TLS to communicate with IP Office, you can skip this
procedure.

Procedure
1. Using IP Office Manager, select File  > Advanced  > Security Settings  > System >

Unsecured Interfaces.

2. In the Application Controls section, select the TAPI check box.

3. Click OK.

4. Select File  > Save Security Settings.

Next steps
Verify that the TCP connection between Avaya Contact Center Select and IP Office is connected.
Open the SIP Gateway Management Client and verify that the CTI Proxy link Transport setting
is TCP and that the link status is CONNECTED.
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Chapter 8: Data Security and Backup

Data privacy and security on Microsoft Azure
Microsoft provides you with a trusted set of cloud services and takes a defense-in-depth approach
to provide you with security on Microsoft Azure. Microsoft helps you get protected faster across
identity, network, and data by combining built-in security controls and partner solutions, and also
provides tools to help you with security management and threat protection. Microsoft Azure DISKs
of each server store all the Avaya Contact Center Select data.

The following are the Defense in Depth (DiD) approaches provided by Microsoft:

• Identity and access: Microsoft provides the users with Role-Based Access Control (RBAC).

For more information on RBAC, see What Azure role-based access control is.

• Applications and data security: The applications and data security are protected by disk
encryption.

For more information on Microsoft Azure disk data encryption, see Azure data security and
encryption best practices-Protect data at rest.

• Network Security: The network security is provided with basic Distributed Denial-Of-Service
(DDOS) protection. The network security group is provided with Microsoft Azure Firewall
service.

• Virtual machine encryption: You can encrypt Microsoft Azure virtual machines using Microsoft
Azure disk encryption to protect the contents of both Windows and Linux virtual machines.
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Microsoft uses BitLocker for Windows and DM-Crypt for Linux to encrypt both the operating
system volume and the data disks.

Microsoft enables connections from customer sites and remote workers to Microsoft Azure Virtual
Networks using Site-to-Site and Point-to-Site VPNs.

• A Site-to-Site (S2S) VPN gateway connection connects your on-premises network to an
Microsoft Azure virtual network over an IPsec/IKE VPN tunnel.

• A Point-to-Site (P2S) VPN gateway connection allows you to create a secure connection to
the virtual network from an individual client computer.

Recovering files from Microsoft Azure virtual machine
backup

About this task
Microsoft Azure Backup service is a secure and cost-effective solution for Avaya Contact Center
Select deployment. You can restore the data with application consistency.
You can configure backup for all four components (IP Office, Avaya Aura® Media Server, Web-
based License Manager, and Avaya Contact Center Select).

Before you begin
Ensure that the resource groups for all the components are available.

Procedure
1. Log in to the Microsoft Azure portal: https://portal.azure.com/.

2. Navigate to Virtual machines.

3. In the left navigation pane, in the Operations section, click Backup.

4. On the Backup screen, perform the following:

In the Recovery Services vault section, select Create new.

Specify the name of the new recovery services vault.

a. In the Resource group field, select the resource group corresponding to the
component.

b. In the Choose backup policy field, select Create a new policy.

c. In the Policy name field, specify the policy name.

d. In the Retention range section, select the retention period according to your
requirements.

e. Click OK.

f. Click Enable Backup.
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5. To back up all the components, repeat the procedure.

For more information on recovering files, see Recover files from Azure virtual machine
backup.
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